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Introduction 

What is MOST? 
MOST (Modular Object Scanning Technology) is The Perfect Scanning Solution.  MOST is a 
comprehensive scanning solution consisting of customizable modular components. Through 
seamless integration with Ricoh products, MOST provides full management and customization 
of multifunctional device activities, including faxing, emailing, file saving and archiving.  MOST 
has the capability to give users and groups access to certain MFP functions based on their 
credentials. It can also keep track of copying activity on a per MFP, user, or group basis.  
Furthermore, MOST MFP Alerts can send out notifications to the appropriate persons about 
various MFP statuses.  In addition, MOST provides a What-You-See-Is-What-You-Get 
(WYSIWYG) console interface design tool that offers an easy way to create, manage and deploy 
users, groups and MFP interfaces.  MOST also offers a  RSA/SSL encryption, Active 
Directory(LDAP) authentication and integration with other third-party products to produce a 
highly scalable solution that will meet the demands of any organization. Ricoh printers can be 
used with MOST to release prints using the Print To Me technology. 
 

System Requirements 

¶ Reform 12 Enterprise or Reform 12 PDC 

¶ For Evaluation and Demonstration: Windows XP, Windows 2003 Server, Windows 
Vista, Windows 7, Windows 2008 and Windows 2008 R2 Server. 32 & 64  Operating Systems 
are Supported 

¶ For Production Systems: Windows 2003 Server, Windows 2008  and Windows 2008 R2 
Server 32 & 64Operating Systems are Supported 

¶ Microsoft SQL Server (SQL Server Express will be automatically installed by the MOST 
installer) 

¶ Microsoft .NET Framework 2.0 (installed automatically if not present on the current 
system) 

¶ Ricoh Java-Enabled MFP (The latest version of the JavaTM Platform should be installed 
on the MFP and printers.) 

¶ Type B, C, D, F, G, H, I, J, K, L, M or 1x to 8x  MFPs supported  

 

Hardware Requirements 
¶ Production System Recommendation for Typical Load of about 200 ς 250 MFPs (These 

numbers are only estimations. High load environments may require multiple servers, or 
additional hardware.) 

1. Windows 2003/2008 32 or 64 bit 
2. Quad Core Processor 
3. 4-8 GB RAM 
4. HDD Space 100 Gigs (Redundancy Recommended) 
5. Battery Backup (UPS) 
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6. Dedicated server, no other software products except for virus and 
security programs. 

 
 

 Server Requirements  
Production System Recommendation (These suggestions are only estimations. High load 
environments may require multiple servers, or additional hardware.)  

¶ Pentium 4 Processor  

¶  4 GB RAM  

¶ HDD Space 100 GB (Redundancy recommended)  

¶ Battery Backup (UPS)  

¶ Dedicated server, no other software products except for virus and security programs.  

¶ For Production Systems: Windows 2003 Server or Windows 2008 Server (64 Bit 
Operating Systems are Supported)  

 

Minimum System Requirements for demonstration purposes only  

¶ Pentium 4 Processor  

¶ 2 GB RAM  

¶ HDD Space 30 GB  

¶ For Evaluation and Demonstration: Windows XP, Windows 2003 Server, Windows 
Vista, Windows 7 or Windows 2008 Server (64 Bit Operating Systems are Supported)  

 

System Requirements for Reform Desktop MOST  
¶ Pentium 4 Processor  

¶ 2 GB RAM  

¶ HDD Space 30 GB  

¶ .Net 2.0 Installed  

¶ Windows XP, Windows Vista, Windows 7 (64 Bit Operating Systems are Supported)  
 

SQL related to Reform  
¶ SQL Express 2005 - Max db size - 5 gigs  

¶ SQL Express 2008 - Max db size - 10 gigs  

¶ SQL Server Group edition - Max db size - Unlimited  

¶ SQL Server Standard - Max db size - Unlimited  

¶ SQL Server Enterprise - Max db size - Unlimited  
 
* The most important part of our solution to keep in mind is the db size. 
Determining the amount of data / Metadata that will be saved as well as the 
retention policies and backup schedules to be used will help determine the SQL 
server type necessary to effectively implement the solution. 
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Antivirus Information 
 
Typically during an installation we request that any antivirus be configured to exclude the 
directory running the Reform/MOST software.  This is because we have seen anti-virus 
applications interfere with the software.  For example, in some cases it may cause a service to 
take longer than expected to start. This could cause the service to time out and fail to start.  
Another issue we have encountered in the past is antivirus scans may lock temporary files to 
scan them while the files are in use by our application.  This could cause sporadic issues such as 
delays or lost documents since files are not able to be normally processed when they are 
locked. There are typically two rules we request for best practices: 
 
1. The antivirus software should exclude the directory where the software is installed. (For 

Example: C:\Program Files\Reform_PDC_v12\ ) 
2. The firewall/antivirus should allow SMTP emails to be sent from the server 
 

Account Creation / Requirements  
¶ Two (2) Domain Accounts:  

o One account for running the services. Password should not expire. 
o One account for logging onto the server and configuring the software. (This is to 
ŜƴǎǳǊŜ ǎƻƳŜƻƴŜ ŘƻŜǎƴΩǘ ŀŎŎƛŘŜƴǘŀƭƭȅ ƭƻŎƪ ƻǳǘ ǘƘŜ ǎŜǊǾƛŎŜ ŀŎŎƻǳƴǘΦύ  

¶ Both accounts should be a local administrator on the Reform servers.  
Both accounts should have full access to the external SQL server (if required). To begin 
implementation the SQL Express that is installed with the Reform PDC software can be used 
until the external SQL server is prepared. All of the data in the SQL Express can also be easily 
migrated into the external SQL server.  

**** Please Note****  
¶ We don't require the SA credentials.  

¶ Typically, we setup the installation with the SQL Express database. Once we are ready to 
move to the external SQL Server, we backup our database (named FSMonitor) and 
restore it to the external SQL Server. This allows the structure and data to remain intact. 
Once the database is added to the external SQL Server, we only need full access to our 
"FSMonitor" database so that we can make adjustments to the tables/views/procedures 
if necessary. We also need read/write access so that we can query and insert into the 
tables. We don't need any access outside of our database.  

¶ The access should be granted to the domain service account that will be used to run the 
software.  

Additional Requirements  
¶ If an email server is involved, what is the server name and credentials if any.  

¶ If a fax server is involved, what is the server name and credentials  

¶ The correct Java versions should be installed onto the MFP devices.  

¶ To rollout to a MFP, we need the IP address. If lists of IPs are available it would be useful 
to keep track of the devices.  
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Reform Ports  

¶ MOST ς 15000 / 15002 / 8080  

¶ P2Me ς 515  

¶ Email ς 25 / 443  

¶ DAC - 80  
 

About MOST 

MOST resides on the Ricoh MFP, or Multifunctional Device. It communicates with the MFP and 
interfaces with a distribution service that will process user input and turn it into an automated 
task. For instance, if a user would like to browse and scan to their home folder, scan to email 
and scan to a third party application such as fax or archive, MOST can provide the user with a 
simple or advanced interface to easily accomplish this without having to scan the document 
more than once. To accomplish this feat, MOST utilizes a modular system of Tabs and 
Collections.  The Windows Active Directory user and group system is then applied to the 
Collections or groups of Tabs. 

 

Tabs and Collections 

Tabs are composed of interface objects geared towards a specific activity.  They contain text 
boxes, drop down menus, buttons, etc. Tabs are self-contained and independent from other 
Tabs. In the diagram below, you will notice a Tab created for each scan activity (Archive, Fax, 
Email, Process).  A single Tab, or several related Tabs, can be grouped into a single Collection or 
assorted collections.  The diagram below displays three different collections: Front Office, 
Warehouse and Marketing. Collections are independent of each other, i.e, the Front Office 
Collection can have entirely different Tabs from the Warehouse Collection.  
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Tabs are included in Collections.  Collections are assigned to users and users are organized into 
groups. 
 

 

Users and Groups 

The Collections available to an individual are customizabƭŜ ƛƴ ǘǿƻ ǿŀȅǎΥ ǘƘǊƻǳƎƘ ǘƘŜ ƛƴŘƛǾƛŘǳŀƭΩǎ 
Windows User name or through the associated group.  Different collections may also be 
assigned to different users.  The Collection displayed for UserA may be different for UserB.  
MOST will also use Active Directory ƎǊƻǳǇǎ ƛŦ ǘƘŜ ǳǎŜǊΩǎ ƛƴŘƛǾƛŘǳŀƭ ǎŜǘǘƛƴƎǎ ŀǊŜ ƴƻǘ ŎƻƴŦƛƎǳǊŜŘΦ  
For example, the group Accounting is configured to view the Front Office and Accounting 
/ƻƭƭŜŎǘƛƻƴǎΦ  LŦ ŀ ǳǎŜǊ ŦǊƻƳ ǘƘŜ ƎǊƻǳǇ ά!ŎŎƻǳƴǘƛƴƎέ ƭƻƎǎ ƛƴǘƻ ah{¢Σ ǘƘŀǘ ǳǎŜǊ ǿƛƭƭ ǎŜŜ ǘƘŜ 
Collections for Front Office and Accounting. To take the concept a step further, if the Manager 
of Accounting is part of the Accounting group, but also has a special Collection assigned to his 
username, he would be able to see everything the Accounting group encompasses in addition 
to his own special Collection.  Users and groups are also used in the cost accounting features of 
MOST.  Users and groups can be setup to limit access to certain functions on the MFP such as 
copying, faxing and scanning.     

MOST Process Flow 

The MOST software is installed on one or more Windows Servers. The MOST MFP Application is 
installed onto a variety of MFPs.  When MOST is used to process documents, the documents 
are scanned and sent to the MOST Manager on one of the MOST servers. The MOST Manager 
will process the documents based on the settings configured on the MOST server.  Once 
processing is complete, the documents are sent to the distribution service. From the 
distribution service, the documents are printed, faxed, emailed or archived as indicated by the 
Tab settings. 
 

Archive 

Fax 

Email 

Process 

Front Office Warehouse  Marketing Collections 
Tabs 
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Terminology 

Here is a list of terms that you will find throughout this document: 

¶ Tabs: Compilation of interface objects designed for a specific purpose. The tabs are 
located along the left side of the screen. Tabs can be created and modified. 

¶ Collections: A group of Tabs. Collections can be modified and customized to include or 
exclude Tabs. Users and groups of users can have more than one collection. Collections are 
listed across the top of the console interface. 

¶ On-screen keyboard: A touch screen version of the keyboard. The on-screen keyboard 
can be accessed by pressing anywhere on an input field. 

¶ WYSIWYG: What You See Is What You Get 

¶ MOST Desktop ς An MFP Emulator (Simulates what you would see on an MFP screen) 

Quick Start 
To get a quick start on using MOST, read the following sections in order: 

¶ Introduction: About MOST (optional but recommended) 

¶ Chapter 1: Sections 1.2-1.4, 1.5.1 

¶ Chapter 2: Section 2.1 

¶ Chapter 3: Section 3.1 (use the default Collections)  

Installation 
To install MOST, download and run the MOST installation routine.  This installation routine can 
be found at www.fabsoft.com >> Downloads. 
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The installer will launch. There is no pre-configuration required to install MOST, so click Next 
and the process will begin.  MOST will install SQL Server Express if it is not already present on 
the system. After it completes, click Finish. MOST is now installed.   
 
If a dedicated SQL Server will be used for MOST, SQL Server Express should still be installed in 
order to populate the FSMonitor database.  One can then import the FSMonitor database into 
the dedicated SQL Server.  Lastly, to finish the configuration, the installed OBDC connection 
(FSMonitorDatasource) should be redirected to the dedicated SQL Server.    
 
The default installation directory for Reform 12 and its plugins is C:\ Program Files\wŜŦƻǊƳΧ\ .  
If you have changed the path during the Reform installation routine, or if you are using a 64 bit 
operating system, please refer to the appropriate path instead of the default one referenced 
throughout this documentation.  
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First-Time MOST Setup and Connection Test 
At this point, you should have a basic understanding of the functionality of MOST. In this 
ǘǳǘƻǊƛŀƭΣ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ōŜ ǳǎƛƴƎ ǘƘŜ ƛƴŎƭǳŘŜŘ MOST Desktop (an MFP Emulator) to simulate a 
MFP running MOST and connecting to a MOST server. Basically whatever you can do on the 
MFP, you can carry out using MOST Desktop and therefore, there is no MFP required for this 
portion of the tutorial. We will then use one of the MOST tabs that are included with the MOST 
installation to perform a Scan To Folder operation, which will scan pages from your MFP and 
save them to a file on your computer. 
 

1. The first thing we need to do is start the server end of the MOST application so that we 
can connect to it from MOST Desktop. Open the MOST Manager by going to: 

 
{ǘŀǊǘҔtǊƻƎǊŀƳǎҔwŜŦƻǊƳΧ>MOST>Manager 

 
2. The MOST Manager will load and the server will be started.  

 

 
 

3. You can see that the MOST Manager is running by looking in the bottom corner of the 
window for the status text. Make sure that it is started; if it is not, click the green Play 
button on the top left of the window. We also need to get the IP address of the server, 
so in the left tree view, click on Manager, and take note of the IP at the bottom-right.  
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4. Now, minimize the MOST Manager to the system tray. We need to start the Reform 
Spooler so that it can process the files that MOST is going to generate at the end of this 
tutorial. Go to Start > Programs > wŜŦƻǊƳΧ> Spooler 

 
5. Within the Spooler application there are Start, Stop and Refresh buttons right below the 

menu bar.   Make sure the spooler is running by clicking the blue Play button on the top-
left of the window, as shown below. 
 

 
 

6. On the bottom left of the Spooler window, you will see the status change to Start  once 
it has started successfully. You can now minimize the Spooler. 

 
7. Next, run MOST Desktop by going to  {ǘŀǊǘ Ҕ tǊƻƎǊŀƳǎ Ҕ wŜŦƻǊƳΧҔ ah{¢ > Misc > 

MOST Desktop. The path looks as follows: 
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*You can also make a shortcut to MOST Desktop on the desktop for your convenience 
by right clicking on the MFP Emulator icon and going to Send To > Desktop(Create 
ShortCut).  

 
8. Upon opening MOST Desktop, the application will launch and you will see the emulated 

MFP screen just as if you were in front of an physical machine.  
 

 
 

9. There should be an Options button above the Log In button which will allow us to 
configure which server and port to connect to.  If this button is not present on MOST 
Desktop, you must first type most:options as the Username  and leave the password 
blank. In order to edit a field (enter data), simply use your mouse to select the field and 
then use your keyboard to type. If you were at the MFP, you would click the field and an 
onscreen keyboard would popup. 
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10. After doing so, click Log In and the Options button will appear.   

 

 
 

11. Now, click on the Options button to set the IP address of the server, as well as the port 
number. Type in the IP address from the MOST Manager from earlier, and then type the 
port number, which is 15000. 
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12. Click OK on the Options screen, then log in with the username demo and the password 
demo. This account is automatically set up when you first install MOST.  

 
 

13. The emulator will now connect to the MOST server and login. Once it logs in, you will 
see a series of collections and tabs. For this tutorial, we will be using the Shared tab in 
the Scan to Folder collection.  To access the Shared tab, click Shared on the left side of 
the screen. 
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14. You will notice several fields on the tab. The File Name field is where you can enter the 

name of the output file that will be generated. The list in the middle of the screen is the 
folder list that is located in C:\ temp.  To view the subfolders, use the + to expand the 
temp folder. (Note: C:\ temp folder is created during the installation of MOST.  If for any 
reason your Listbox is not populated, check and make sure the temp folder and the 
ǎǳōŦƻƭŘŜǊǎ ŜȄƛǎǘ ƻǘƘŜǊǿƛǎŜ ȅƻǳΩƭl need to create them.) For this example, we will be 
selecting the Test 2 ŘƛǊŜŎǘƻǊȅ ŀƴŘ ƎƛǾƛƴƎ ǘƘŜ ŦƛƭŜ ǘƘŜ ƴŀƳŜ ƻŦ ΨŘŜƳƻ ǘŜǎǘΩΣ ǎƻ ŎƭƛŎƪ ƻƴ Test 
2 ƛƴ ǘƘŜ ŦƻƭŘŜǊ ƭƛǎǘ ǘƻ ǎŜƭŜŎǘ ƛǘΣ ŀƴŘ ǘƘŜƴ ŜƴǘŜǊ ΨŘŜƳƻ ǘŜǎǘΩ ƛƴ ǘƘŜ ŦƛƭŜƴŀƳŜ ŦƛŜƭŘΦ CƻǊ ǘƘƛǎ 
example, we can leave the rest of the fields alone. 

 

 
 

15. Ensure that your tab looks like the screenshot above. Then click the Scan button. The 
emulator will allow you to choose an image to simulate scanning. You also have the 
ability to use an attached scanner to simulate the scan. 
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16. For Filter, select the file type you will be browsing to.  For the demonstration, we have 

included a TIF file named SampleTif.tif in C:\ Program Files\wŜŦƻǊƳΧ\ Misc\  that can be 
used.  If you have any TIF/JPG that you would like to use, you can do so as well by 
selecting the appropriate Filter in the drop down box.  Click .ǊƻǿǎŜΧ to navigate your 
hard drive for the file type you selected.  Select one and click Open. 
 

 
 

17. Click OK and your process is complete. 
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18. After a few seconds, go into the Status tab.  Once the Spooler has processed the file, 
you will be given a status about the results of the scan.  If the file was saved correctly in 
the directory, the status will say Successful. 
 

 
 

19.  You can also see the result in the folder that was selected. In our case, it was 
C:\ temp\ Test2Φ LŦ ȅƻǳ ƴŀǾƛƎŀǘŜ ǘƻ ǘƘƛǎ ŦƻƭŘŜǊΣ ȅƻǳ ǿƛƭƭ ǎŜŜ Ψdemo test.PDFΩ.  It will 
contain the image(s) chosen in the emulator. 

 
 

The emulator shows you exactly what you would see on an MFP, and it functions in the same 
way. This same process could be tested with the same exact steps, but by installing MOST on 
the MFP by following the instructions in this manual.  Please see section 1.2 Installing MOST on 
your MFP: Getting Started. 
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Designing Your First MOST Tab  
This guide will walk you through creating your first fully-functional MOST tab that will scan 
pages from the MFP and save them as a PDF file on your hard drive. It requires Reform 
Enterprise/PDC v12 and MOST to be already installed on your system. 
 
 You can use either MOST Desktop to walk through the tutorial or do it at an actual MFP.  In 
order to carry this out on an MFP, it is required that you install MOST on an MFP.  Please see 
1.2 Installing MOST on your MFP: Getting Started 
 

1. Open the MOST Designer by going to: 
Start > Programs > Reform > MOST > Designer 
 

2. Go to File > New HVGA/WVGA/SVGA. Depending on the screen size of the MFP you 
are using, please select the appropriate option. (Note: Because of the limited screen 
size, the tutorial for 4Line tabs can be found in the ά5ŜǎƛƎƴƛƴƎ ¸ƻǳǊ CƛǊǎǘ ah{¢ п[ƛƴŜ 
¢ŀōέ section.) 

 

 
 

3. If you create a new tab, the New Tab Wizard will appear. The wizard will allow you 
to set the values of several properties of the tab.  

4. Fill in the following values for each property in the New Tab Wizard: 
a. Name: STFSample 
b. Alias: STF 
c. Collections: add a new collection and name it Sample. 
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d. Users and Groups: Check the box next to demo. Click Finish. 

 
 

5. After you finish stepping through the New Tab Wizard, your tab will be created. For 
the example, we created a WVGA tab, but the results will be the same regardless of 
the size of the tab you created. 

6. We are going to add several objects to the tab. You will notice the list of items on 
the left pane. Scroll down to find the TextBox object. Click on TextBox and drag it on 
to the tab, as shown below. 
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7. After you have dragged the TextBox on to the form, the TextBox will be created. Go 
to  the Object Properties, and set the following property values: 
a. Font Size: Small 
b. Link ID: 0 
c. Name: TextBox1 
d. Process Reset: No 
e. Required: Yes 
f. Text: <leave blank> 
g. Keyboard Title: Filename 
h. Type: Standard 
i. Validate: <leave blank> 
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8. Next, we will be adding a Tree Listbox Object to our tab. Add it to the tab the same 
way you added the TextBox by clicking and dragging the Tree ListBox object on to 
the tab. 

 

 
 

9. After you have dragged the Tree ListBox on to the tab, the object will be created. Set 
the following property values: 
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a. Button Height: 20 
b. Font Size: Small 
c. Child Select: Off 
d. Name: ListBox1 
e. Process Reset: No 
f. Required: Yes 
g. Type: FileList 
h. Directory: C:\ temp\ 
i. Show Files: No 

 
 

10. Next, we will be adding a Log Out button to our form. Find Log Out under Button 

Objects in the object list, and drag it on to the tab. 
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11. After you have dragged the Log Out button on to the tab, the object will be created.  
Set the following property values: 
a. Font Color: Black 
b. Font Size: Small 
c. Name: Button1 
d. Text: Log out 

 

 
 

12. Next, we will be adding a Process button to our form. Find Process under Button 

Objects in the object list, and drag it on to the tab. 
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13. After you have dragged the Process button on to the tab, the object will be created.  
Set the following property values: 
a. Font Color: Black 
b. Font Size: Small 
c. Continue: On 
d. Direct Copy: Off 
e. Name: Button2 
f. Scan Preview: Off 
g. Text: Scan 

 
 

 
 

14. Go to File > Save to save your tab. 
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15. Next, we need to make sure the Reform Spooler is stopped. Open the Spooler by 
going to {ǘŀǊǘ Ҕ tǊƻƎǊŀƳǎ Ҕ wŜŦƻǊƳΧ> Spooler. 

16. Once it opens, click the Stop button on the top left. 
 

 
 

17. ̧ ƻǳ ǿƛƭƭ ǎŜŜ ǘƘŀǘ ǘƘŜ ǎǘŀǘǳǎ ƛƴ ǘƘŜ ōƻǘǘƻƳ ƭŜŦǘ ƻŦ ǘƘŜ {ǇƻƻƭŜǊ ƳƻƴƛǘƻǊ ǎŀȅǎ άStopέΦ 
18. Once the Spooler has been stopped, log into MOST Desktop located on your desktop 

if you made a shortcut previously or at Start > Programs Ҕ wŜŦƻǊƳΧҔ ah{¢ > Misc > 
MOST Desktop.   

Username = demo 
Password = demo 
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19. Once it connects and logs in, select your new collection Sample, and your tab STF.  
 

 
 

20. bƻǿ ƭŜǘΩǎ Ŧƛƭƭ ƛƴ ǎƻƳŜ ōŀǎƛŎ ƛƴŦƻǊƳŀǘƛƻƴ ƻƴ ƻǳǊ ǘŀō ŀƴŘ ǇŜǊŦƻǊƳ ŀ Scan To Folder. 
21. In the top TextBox, enter the text SampleFileName. In the Tree ListBox, expand the 

temp folder, select Test and then Test 1-1. 
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22. Last, press Scan. If you are at an MFP, it  will scan any pages that are in the feeder 

and ask you if you are finished. If you are using MOST Desktop, you will be prompted 

to select an image to simulate scanning. For assistance on how to do so, please see 

άFirst-Time MOST Setup and Connection TestέΥ {ǘŜǇ мр.  Select an image and click 

OK. 

23. After the process completes, 2 files will be created in your Reform Spooler folder. 

Since we stopped the Spooler, the files will not be processed yet. Open an Explorer 

window and navigate to C:\ Program Files\wŜŦƻǊƳΧ\ Spooler. 

 
 

24. You will notice two files in this directory. They have the same file names, aside from 
the extensions, so they will be processed together. These were created by MOST to 
be processed by Reform. 

 
25. Open the Workflow Designer.  It will allow us to create the forms we need to finish 

our process.  Click {ǘŀǊǘ Ҕ tǊƻƎǊŀƳǎ Ҕ wŜŦƻǊƳΧҔ²ƻǊƪŦƭƻǿ 5ŜǎƛƎƴŜǊ. We need to 
create a workflow that will handle processing data that you submit from the MOST 
tab we just created. 

 
26. Once open, we must go to CƛƭŜ Ҕ bŜǿΧ 



MOST 29 

 

                                                                             v2.5 
 

 
 

27. Select άDocument Automationέ and click Ok. 

 

 

 
28. You will notice that your Inputs, Processes and Outputs have been populated by the 

various plugins you might have installed, where MOST is one of the Inputs. 
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29.  We must first drag a From MOST object onto the workflow.  To do so, hover your 

mouse over From MOST until the cursor turns into the small hand and From MOST 

becomes underlined.  Then click and hold your left mouse button and drag the 

object onto the whitespace or digital workflow.   Release the mouse button once 

you have your desired position. 
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*You will be prompted with a dialog to describe the input. 

 
30. Enter a description for the object you just added.  This is done by typing in the 

provided box.  Type άMOST Sampleέ and click Finish. This will take you back to your 

workflow. 

 

 
 

31. Your input has been added to the workflow 

 
 

32. ¢ƻ ŎƻƴŦƛƎǳǊŜ ǘƘŜ άah{¢ {ŀƳǇƭŜέ LƴǇǳǘΣ ȅƻǳ Ƴǳǎǘ ǊƛƎƘǘ ŎƭƛŎƪ ƻƴ άah{¢ {ŀƳǇƭŜέ ŀƴŘ 

select /ƻƴŦƛƎǳǊŀǘƛƻƴΧ.  ¢Ƙƛǎ Ŏŀƴ ŀƭǎƻ ōŜ ŘƻƴŜ ōȅ ŘƻǳōƭŜ ŎƭƛŎƪƛƴƎ ƻƴ ǘƘŜ άah{¢ 

{ŀƳǇƭŜέ ƻōƧŜŎǘΦ 
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33. You will be prompted to select one of the two previosuly mentioned files which 

were created by MOST for Reform to process.  Selecting the file will automatically 
create a blank form for you with the same name as the file (STFSample.FOM).  Click 
the small folder icon and you will be taken to a browser window.  Navigate to the 
Spooler Directory (C:\ Program Files\wŜŦƻǊƳΧ\ Spooler) and select either of the two 
STFSample files.  After doing so, click Open. 

 

 
 

34. Verify that the correct file is selected and click Finish. 
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35. ̧ ƻǳ ǿƛƭƭ ƴƻǘƛŎŜ ǘƘŀǘ ȅƻǳǊ άah{¢ {ŀƳǇƭŜέ ŎŀǇǘƛon has turned blue because it has 

been configured.  Next, since we are doing a scan to PDF workflow, we need a 

SaveToFile hǳǘǇǳǘ ǘƻ ŎƻƳǇƭŜǘŜ ƛǘΦ  5ǊŀƎ ŀ {ŀǾŜ¢ƻCƛƭŜ ƻōƧŜŎǘ ǳƴŘŜǊƴŜŀǘƘ άah{¢ 

{ŀƳǇƭŜέΦ 

 

36.  Once added to the workflow, you will be prompted to describe the newly added   

hǳǘǇǳǘΦ  ¢ȅǇŜ ά{ŀƳǇƭŜCƛƭŜέ ƛƴ ǘƘŜ ōƻȄ ǇǊƻǾƛŘŜŘ ŀƴŘ ŎƭƛŎƪ Finish.  
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37. Once you click Finish, you are taken back to your workflow.  Your ά{ŀƳǇƭŜCƛƭŜέ 
Output will have a Red Caption because it is not yet configured. To configure 
ά{ŀƳǇƭŜCƛƭŜέΣ ȅƻǳ Ƴǳǎǘ ŦƛǊǎǘ ŎƻƴƴŜŎǘ ǘƘŜ From MOST ƻōƧŜŎǘ ǘƛǘƭŜŘ άah{¢ {ŀƳǇƭŜέΦ  
¢ƻ Řƻ ǎƻΣ ŦƛǊǎǘ ǎŜƭŜŎǘ ǘƘŜ άAdd Connectorέ ōǳǘǘƻƴ ŦǊƻƳ ǘƘŜ ƳŜƴǳ ōŀǊΦ  bŜȄǘΣ ŘǊŀƎ 
ȅƻǳǊ ƳƻǳǎŜ ŦǊƻƳ ǘƘŜ ǎƳŀƭƭ άxέ ǳƴŘŜǊƴŜŀǘƘ άah{¢ {ŀƳǇƭŜέ ǘƻ ǘƘŜ ǎƳŀƭƭ άxέ ŀōƻǾŜ 
ά{ŀƳǇƭŜCƛƭŜέ ŀǎ ǇƛŎǘǳǊŜŘ below. When the connection is complete, the connecter 
will turn black (if red, connection has not been made correctly, try again) and the 
άah{¢ {ŀƳǇƭŜέ ŎŀǇǘƛƻƴ ǿƛƭƭ ǘǳǊƴ green. 

 
 

38. When the connection is made correctly, you will be prompted to configure 
ά{ŀƳǇƭŜCƛƭŜέΦ  /ƭƛŎƪ Yes.   
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39. The SaveToFile wizard will now guide you through the necessary steps to get the 
correct output file in the correct location.  It uses information from the file that you 
ǎŜƭŜŎǘŜŘ ǿƘƛƭŜ ŎƻƴŦƛƎǳǊƛƴƎ άah{¢ {ŀƳǇƭŜέΦ  ¢Ƙƛǎ ŦƛƭŜ Ƙŀǎ all the information the 
user selected while at the MFP screen or through MOST Desktop.  The first prompt 
ƛǎ ǘƘŜ ǘȅǇŜ ƻŦ ŦƛƭŜ ȅƻǳ ǿŀƴǘ ǘƻ ǎŀǾŜΦ  {ŜƭŜŎǘ άPDF Fileέ ŀƴŘ ŎƭƛŎƪ Next. 

 

 
 

40. Next is the directory where the file will be saved.  If you remember correctly, this 
directory (C:\ Temp\ Test1\ Test1-1\ ) should be part of the information in the file 
we selected.  To use the information stored in the data file, click the button titled 
άClick here to select variable informationέΦ 
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41. This will reveal a list box with available directories.  As you can see, the list box 
(_LISTBOX1) which we created in our sample tab is listed. Select _LISTBOX1 from 
the list and click Next. 

 

 
 

42. It will now ask you to select a subfolder.  For this demonstration we do not require 

one so you can click Stop Looping. 
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43. The final prompt is for the FileName.  Since the filename has already been specified 

ƛƴ ǘƘŜ ŦƛƭŜ ǘƘŀǘ ah{¢ ƎŜƴŜǊŀǘŜŘΣ ǿŜ ǿŀƴǘ ǘƻ ŎƭƛŎƪ ǘƘŜ ōǳǘǘƻƴ ǘƛǘƭŜŘ άClick here to 

select variable informationέΦ 

 

 
 

44. This will reveal a list which available data in the file generated by MOST.  As you can 

see, _TEXTBOX1 was the object we created on the tab which held the name of our 

file.  We want to select _TEXTBOX1 from the list and click Finish. 
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45. You have completed configuring your workflow, but no changes have been made 
to your form just yet. You will notice that both captions are now green since they 
have been successfully configured.   

 

 
 

46.  To make all the appropriate changes, the workflow must be executed.  This is done 

by clicking ǘƘŜ άExecuteέ ōǳǘǘƻƴ  on the menu bar.   After execution, you 
will be notified about what has taken place.  Click OK. 

 
 

47. You have the ability to save the workflow you just created to a file, so that it can be 
accessed in the future in case you want to reconfigure something on the form.  This 
is done by going to File > Save in the Workflow Designer and is optional for our 
example.  You can now exit the Workflow Designer.   

 

48. Open the Reform Spooler. Click the Refresh button.  You will now see your new 
form STFSample in the form list. The form was automatically saved by the wizard 
and the filename was taken from the print stream that it was set up with. 
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49. Start the Reform Spooler . 

 
50. The spooler files that were created earlier will now be processed by the new form 

that we created. Click the Process Results tab in Reform Spooler to view this 

information. 
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51. This will save the pages you scanned earlier and save them into a PDF file that you 

can see in C:\ Temp\ Test1\ Test1-1.  Now you can go back to your MFP or MOST 

Desktop and utilize your newly created tab.  If the Reform Spooler is running, the 

process you configured will be carried out automatically for you. 

 
 
Keep in mind that while we performed a simple SaveToFile in this example, it would be very 
easy to configure your scanned documents to be archived, emailed, or faxed, just by adding 
different devices to the digital workflow in the Workflow Designer. 
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4 Line MFP Quick Overview 

 

 

Creating a 4 Line Tab 

1. This section of the tutorial will simply demonstrate how to configure a 4Line screen 
to scan a file to a static folder. This tutorial requires a 4Line device. This cannot be 
demonstrated with MOST Desktop. 

2. 4 Line tabs are created similar to the other screen types.  To create a new 4 Line 
screen, click File > New > 4 LINE. 

3. Because of the limited screen size, 4 Line tabs are limited to only a few properties. 
4. The Tab Wizard will appear.  Enter STFSample4Line as the Name and click Next. 

 

 
 

5. Enter STF New as the Alias and click Next. 
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6. By default there is a colleŎǘƛƻƴ ƴŀƳŜŘ άп[ƛƴŜέΦ ²Ŝ ǿƛƭƭ ŀŘŘ ƻǳǊ ƴŜǿ ǘŀō ǘƻ ǘƘƛǎ 

collection by selecting this collection. Then, using the Arrow buttons, we will move 

ǘƘŜ п[ƛƴŜ ŎƻƭƭŜŎǘƛƻƴ ŦǊƻƳ ǘƘŜ ά!ǾŀƛƭŀōƭŜέ ǘƻ ǘƘŜ ά!ŘŘŜŘέ ōǳŎƪŜǘΦ /ƭƛŎƪ Next. Note: 

Because of the limited screen size on the 4Line devices, only the first 3 4Line tabs will 

be displayed. Two are installed by default and this will be the third. 

 

7. Next we will configure what users and groups will have access to the 4Line 
collection. For demonstration purposes, we will selecǘ ōƻǘƘ ǘƘŜ ǳǎŜǊ άŘŜƳƻέ ŀƴŘ ǘƘŜ 
ά5ƻƳŀƛƴ ¦ǎŜǊǎέ DǊƻǳǇ ōȅ ŎƘŜŎƪƛƴƎ ǘƘŜ ōƻȄŜǎ ƴŜȄǘ ǘƻ ¦ǎŜǊǎ ŀƴŘ DǊƻǳǇǎΦ /ƭƛŎƪ Finish. 
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8. After the tab is created, ensure that the Object Properties are as follows: 
 

 
 

9. Next, we need to configure the process button. To configure the Process button, 
simply click on the center button on the tab. 

 
10. The button has the following set of properties: 

a. Attributes: No attributes need to be selected 
b. DLL: (None) 
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11. Once you have configured the tab Go to File > Save to save your tab. 
 

 

12. Next, we need to make sure the Reform Spooler is stopped. Open the Spooler by 
going to {ǘŀǊǘ Ҕ tǊƻƎǊŀƳǎ Ҕ wŜŦƻǊƳΧ> Spooler. 
 

13. Once it opens, click the Stop button on the top left. 
 

 
 

14. ̧ ƻǳ ǿƛƭƭ ǎŜŜ ǘƘŀǘ ǘƘŜ ǎǘŀǘǳǎ ƛƴ ǘƘŜ ōƻǘǘƻƳ ƭŜŦǘ ƻŦ ǘƘŜ {ǇƻƻƭŜǊ ƳƻƴƛǘƻǊ ǎŀȅǎ άStopέΦ 
15. Now, we can scan a document to create a sample data stream. 
16. At the MFP, login to the MFP. Press the login button.  
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17. Enter your username and password using the letter keys to the left of the screen.  If 

you would like to cancel your login, press the Escape button. 

          

18. bƻǿΣ ǇƭŀŎŜ ŀ ŘƻŎǳƳŜƴǘ ǘƻ ōŜ ǎŎŀƴƴŜŘ ŀƴŘ ǇǊŜǎǎ ǘƘŜ άSTF Newέ ōǳǘǘƻƴΦ  

 

19. Select the appropriate scan setting for the Feeder or Manual, depending on where 

you placed the document. 

 

20. After the process completes, you can log out of the MFP using the Escape button. 
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21. Two files will be created in your Reform Spooler folder. Since we stopped the 

Spooler, the files will not be processed yet. Open an Explorer window and navigate 

to C:\ Program Files\wŜŦƻǊƳΧ\ Spooler. 

 
 

22. You will notice two files in this directory. They have the same file names, aside from 
the extensions, so they will be processed together. These were created by MOST to 
be processed by Reform. 

 
23. Open the Workflow Designer.  It will allow us to create the forms we need to finish 

our process.  Click {ǘŀǊǘ Ҕ tǊƻƎǊŀƳǎ Ҕ wŜŦƻǊƳΧҔ²ƻǊƪŦƭƻǿ 5ŜǎƛƎƴŜǊ. We need to 
create a workflow that will handle processing data that you submit from the MOST 
tab we just created. 

 
24. Once open, we must go to CƛƭŜ Ҕ bŜǿΧ 
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25. Select άDocument Automationέ and click Ok. 

 

 

 
26. You will notice that your Inputs, Processes and Outputs have been populated by the 

various plugins you might have installed, where MOST is one of the Inputs. 
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27.  We must first drag a From MOST object onto the workflow.  To do so, hover your 

mouse over From MOST until the cursor turns into the small hand and From MOST 

becomes underlined.  Then click and hold your left mouse button and drag the 

object onto the whitespace or digital workflow.   Release the mouse button once 

you have your desired position. 
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*You will be prompted with a dialog to describe the input. 

 
28. Enter a description for the object you just added.  This is done by typing in the 

provided box.  Type άMOST Sampleέ and click Finish. This will take you back to your 

workflow. 

 

 
 

29. Your input has been added to the workflow 

 
 

30. ¢ƻ ŎƻƴŦƛƎǳǊŜ ǘƘŜ άah{¢ {ŀƳǇƭŜέ LƴǇǳǘΣ ȅƻǳ Ƴǳǎǘ ǊƛƎƘǘ ŎƭƛŎƪ ƻƴ άah{¢ {ŀƳǇƭŜέ ŀƴŘ 

select /ƻƴŦƛƎǳǊŀǘƛƻƴΧ.  ¢Ƙƛǎ Ŏŀƴ ŀƭǎƻ ōŜ ŘƻƴŜ ōȅ ŘƻǳōƭŜ ŎƭƛŎƪƛƴƎ ƻƴ ǘƘŜ άah{¢ 

{ŀƳǇƭŜέ ƻōƧŜŎǘΦ 
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31. You will be prompted to select one of the two previosuly mentioned files which 

were created by MOST for Reform to process.  Selecting the file will automatically 
create a blank form for you with the same name as the file (STFSample.FOM).  Click 
the small folder icon and you will be taken to a browser window.  Navigate to the 
Spooler Directory (C:\ Program Files\wŜŦƻǊƳΧ\ Spooler) and select either of the two 
STFSample files.  After doing so, click Open. 

 

 
 

32. Verify that the correct file is selected and click Finish. 



MOST 51 

 

                                                                             v2.5 
 

 

33. ̧ ƻǳ ǿƛƭƭ ƴƻǘƛŎŜ ǘƘŀǘ ȅƻǳǊ άah{¢ {ŀƳǇƭŜέ ŎŀǇǘƛƻƴ Ƙŀǎ ǘǳǊƴŜŘ ōƭǳŜ ōŜŎŀǳǎŜ ƛǘ Ƙŀǎ 

been configured.  Next, since we are doing a scan to PDF workflow, we need a 

SaveToFile hǳǘǇǳǘ ǘƻ ŎƻƳǇƭŜǘŜ ƛǘΦ  5ǊŀƎ ŀ {ŀǾŜ¢ƻCƛƭŜ ƻōƧŜŎǘ ǳƴŘŜǊƴŜŀǘƘ άah{¢ 

{ŀƳǇƭŜέΦ 

 

34.  Once added to the workflow, you will be prompted to describe the newly added   

hǳǘǇǳǘΦ  ¢ȅǇŜ ά{ŀƳǇƭŜCƛƭŜέ ƛƴ ǘƘŜ ōƻȄ ǇǊƻǾƛŘŜŘ ŀƴŘ ŎƭƛŎƪ Finish.  
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35. Once you click Finish, you are taken back to your workflow.  Your ά{ŀƳǇƭŜCƛƭŜέ 
Output will have a Red Caption because it is not yet configured. To configure 
ά{ŀƳǇƭŜCƛƭŜέΣ ȅƻǳ Ƴǳǎǘ ŦƛǊǎǘ ŎƻƴƴŜŎǘ ǘƘŜ From MOST ƻōƧŜŎǘ ǘƛǘƭŜŘ άah{¢ {ŀƳǇƭŜέΦ  
¢ƻ Řƻ ǎƻΣ ŦƛǊǎǘ ǎŜƭŜŎǘ ǘƘŜ άAdd Connectorέ ōǳǘǘƻƴ ŦǊƻƳ ǘƘŜ ƳŜƴǳ ōŀǊΦ  bŜȄǘΣ ŘǊŀƎ 
ȅƻǳǊ ƳƻǳǎŜ ŦǊƻƳ ǘƘŜ ǎƳŀƭƭ άxέ ǳƴŘŜǊƴŜŀǘƘ άah{¢ {ŀƳǇƭŜέ ǘƻ ǘƘŜ ǎƳŀƭƭ άxέ ŀōƻǾŜ 
ά{ŀƳǇƭŜCƛƭŜέ ŀǎ pictured below. When the connection is complete, the connecter 
will turn black (if red, connection has not been made correctly, try again) and the 
άah{¢ {ŀƳǇƭŜέ ŎŀǇǘƛƻƴ ǿƛƭƭ ǘǳǊƴ green. 

 
 

36. When the connection is made correctly, you will be prompted to configure 
ά{ŀƳǇƭŜCƛƭŜέΦ  /ƭƛŎƪ Yes.   
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37. The SaveToFile wizard will now guide you through the necessary steps to get the 
correct output file in the correct location.  It uses information from the file that you 
ǎŜƭŜŎǘŜŘ ǿƘƛƭŜ ŎƻƴŦƛƎǳǊƛƴƎ άah{¢ {ŀƳǇƭŜέΦ  ¢Ƙƛǎ Ŧile has all the information the 
user selected while at the MFP screen or through MOST Desktop.  The first prompt 
ƛǎ ǘƘŜ ǘȅǇŜ ƻŦ ŦƛƭŜ ȅƻǳ ǿŀƴǘ ǘƻ ǎŀǾŜΦ  {ŜƭŜŎǘ άPDF Fileέ ŀƴŘ ŎƭƛŎƪ Next. 

 

 
 

38. Next is the directory where the file will be saved.  Because the 4Line screens are 
limited, the directory the document is saved to for this tutorial will be static. To 
select a directory, click the Browse button. Then select C:\ Temp\  as the 
destination. 
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39. It will now ask you to select a subfolder.  For this demonstration we would like each 

ǳǎŜǊΩǎ ŘƻŎǳƳŜƴǘǎ ǘƻ ōŜ ǎŀǾŜŘ ǘƻ ŀ ǳƴƛǉǳŜ ŦƻƭŘŜǊΦ  CƻǊ Folder1, we will select the 

username that scanned.  Click the button Click here to select variable (dynamic) 

information. 
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40. This will reveal a list which available data in the file generated by MOST.  As you can 

see, _MOSTUSERNAME ƛǎ ǘƘŜ ǳǎŜǊΩǎ ǳǎŜǊƴŀƳŜΦ  ²Ŝ ǿŀƴǘ ǘƻ ǎŜƭŜŎǘ 

_MOSTUSERNAME from the list and click Next. 

 

41. We do not require additional subfolders, so you can click Stop Looping. 

 



MOST 56 

 

                                                                             v2.5 
 

 

42. The final prompt is for the FileName.  To keep the document unique to a user, we 

ǿƛƭƭ ǎŜƭŜŎǘ ǘƘŜ ǳǎŜǊΩǎ ǳǎŜǊƴŀƳŜ ŀǎ ǘƘŜ ŦƛƭŜƴŀƳŜΦ ¢ƻ Řƻ ǘƘƛǎΣ ǿŜ ǿŀƴǘ ǘƻ ŎƭƛŎƪ ǘƘŜ 

ōǳǘǘƻƴ ǘƛǘƭŜŘ άClick here to select variable informationέΦ 

 

 
 

43. This will reveal a list which available data in the file generated by MOST.  As you can 

see, _MOSTID Ŏƻƴǘŀƛƴǎ ǳǎŜǊΩǎ ǳǎŜǊƴŀƳŜ ŀǎ ǿŜƭƭ ŀǎ ŀ ŘŀǘŜ ŀƴŘ ǘƛƳŜ ǾŀƭǳŜΦ  ¢Ƙƛǎ ǾŀƭǳŜ 

will help keep the filename unique as well as give the file a timestamp of when it 

was scanned at the MFP. We want to select _ MOSTID from the list and click Finish. 
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44. You have completed configuring your workflow, but no changes have been made 
to your form just yet. You will notice that both captions are now green since they 
have been successfully configured.   

 

 
 

45.  To make all the appropriate changes, the workflow must be executed.  This is done 

ōȅ ŎƭƛŎƪƛƴƎ ǘƘŜ άExecuteέ ōǳǘǘƻƴ  on the menu bar.   After execution, you 
will be notified about what has taken place.  Click OK. 



MOST 58 

 

                                                                             v2.5 
 

 
 

46. You have the ability to save the workflow you just created to a file, so that it can be 
accessed in the future in case you want to reconfigure something on the form.  This 
is done by going to File > Save in the Workflow Designer and is optional for our 
example.  You can now exit the Workflow Designer.   

 

47. Open the Reform Spooler. Click the Refresh button.  You will now see your new 
form STFSample4Line in the form list. The form was automatically saved by the 
wizard and the filename was taken from the print stream that it was set up with. 

 

 
 

48. Start the Reform Spooler . 
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49. The spooler files that were created earlier will now be processed by the new form 

that we created. Click the Process Results tab in Reform Spooler to view this 

information. 

 

50. This will save the pages you scanned earlier and save them into a PDF file that you 

can see in C:\ Temp\ <UserName> (For this example: C:\Temp\Demo\).  Now you can 

go back to your MFP and utilize your newly created tab.  If the Reform Spooler is 

running, the process you configured will be carried out automatically for you. 
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51. Keep in mind that while we performed a simple SaveToFile in this example, it would 
be very easy to configure your scanned documents to be archived or emailed, just by 
adding different devices to the digital workflow in the Workflow Designer. Also, 
using the workflow designer, different folder structures or file naming conventions 
could be implemented. 
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Understanding and Working with the Default MOST Screens 
With the default MOST installation, there are three Collections installed: Scan To Folder, Email 
and Admin. The Scan To Folder collection consists of four tabs: Home, Simple Home, Shared 
and Status. The Email collection consists of five tabs: Email, Simple Email, Email Self, Multi and 
Status.  The Admin collection has one tab installed by default: Email. 
 
NOTE: The Reform Email plugin is required in order to send emails using the Email collection. 
It is recommended that the RM_Email_Monitor service has a local administrative service 
logon account.  Please see the Reform Email manual for more information. 
 

Scan To Folder 
Home ς The LDAP tab gives users access to their Home Directory (LDAP must be enabled and 
home directories must be configured on the LDAP system).  Users have the ability to browse to 
available folders in their home directories.  This screens gives options for file name and scan 
settings.  In addition, it also allows users to select an output file type of either PDF or TIF and 
set a PDF password (if using PDF). 
 

 
 

Simple Home ς Similar to LDAP, this tab allows you to scan to your Home Directory.  Instead of 
having a choice of a sub folder, here you scan directly to the root of your Home Directory. The 
location of your home directory is displayed for your convenience. 
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Sharedς The Manual tab gives the user access to the C:\Temp\ directory by default.  The 
directory can be changed to any location, including a share network path.  Users can enter a file 
name, configure scan settings and use one of two scan buttons (Scan and Scan with Preview).   

 
 
 

Status ς The Status tab shows the results of your Scan To Folder activity.  It only displays the 
results of the user that is logged into MOST.  It breaks down each scan by the time the 
document was scanned, the filename and the status (Successful or Failed).   
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Email  
Email ς The LDAP tab gives users the most powerful approach to email by utilizing LDAP 
searching. Users can add recipients based on searches using first and last name.  Manual 
ŀŘŘǊŜǎǎŜǎ Ŏŀƴ ōŜ ŀŘŘŜŘ ŀǎ ǿŜƭƭ ōȅ ǳǎƛƴƎ ǘƘŜ aŀƴǳŀƭ ōǳǘǘƻƴΦ !ƴ ά9Ƴŀƛƭ /ƻǇȅ ǘƻ {ŜƭŦέ ƻǇǘƛƻƴ ƛǎ 
also available by checking the box above the Send button. 

 
 

Simple Email ς The Email tab is the simplest tab in the Email collection.  It gives user the option 
to manually type in email addresses in the Email To field, as well as fields for a subject and 
body.   



MOST 64 

 

                                                                             v2.5 
 

 
 

 
Email Self ς The Email Self tab provides a quick and simple solution to sending yourself an email 
with scanned documents.  You have the option of sending with Scan Preview or without it.  
 

 
 

Multi  ς The Multi tab gives the user a better approach to email by giving more options such as 
t5C tŀǎǎǿƻǊŘ ŀƴŘ ǘƘŜ 9Ƴŀƛƭ ¢ƻ {ŜƭŦ ŎƘŜŎƪōƻȄΦ  ¢ƘŜ ά!ŘŘ ŀ wŜŎƛǇƛŜƴǘέ ōǳǘǘƻƴ ƛǎ ǳǎŜŘ ǘƻ 
populate the Recipients list with email addresses.   
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Status ς The Status tab displays the results of your sent emails.  It breaks each email down by 
date and time submitted, email recipient and status (Successful, Failed or Retrying).   
 

 
 

 

Setting Maximum Email PDF Attachment Size 

 

Reform will attempt to split the file sizes below the selected amount.  However, if you select 
100 KB as the limit, and the user scans 1 page that is larger than 100 KB, it cannot be split.  

However, if you select 100 KB as the limit, and the user scans 1 page that is larger than 

100 KB, it cannot be split.  
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Go to Start\Programs\Reform\Designer. Open the File tab and click on Page Setup 
 

 
 

Click on Attachment Setup 
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Open the PDF Settings 

 
 

There you can select the Maximum File Size.  
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Admin 
Email ς The Admin Email screen provides administrators with a quick and easy way of 
configuring the global variables for your Email Server.  The settings available are: Email Server 
Type, Email Server Name, User Name, and User Password.  
 

 
Email Server Types 
The available Email Server Types are: SMTP, Exchange2003, Exchange2007, and 
Exchange2010.  The provided drop down box is used to select one of the options.  If using SMTP 
or Exchange2003, the Email Server Name must also be specified.  It is recommended to leave 
username and password blank if using Exchange2003, Exchange2007 or Exchange 2010 as they 
will be defaulted to the username and password of the account logged into MOST.  For 
seamless integration, LDAP is recommended for the Exchange server types.  When finished, 
click the Save button to update global variables. 
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4Line Screens 

With the default MOST installation, there are 2 tabs installed: Scan To Folder and Email in the 
4Line collection. Note: The 4Line devices can only display 1 collection.  
 
NOTE: The Reform Email plugin is required in order to send emails using the Email tab. It is 
recommended that the RM_Email_Monitor service has a local administrative service logon 
account.  Please see the Reform Email manual for more information. 
 

 
 

To scan using Save To Folder or Email, simply press the associated button on the MFP.  The 
Folder button will scan the document with a default file name to your home folder. The Email 
button will scan the document to your own email address.  The home folder and email address 
can either be configured within MOST if the account is a MOST account or within LDAP if the 
users are authenticating to LDAP. 
 
Once you select which process you would like to use, the MFP will prompt you to select 
whether you would like to scan from the Feeder or Manual (Glass).   
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Chapter 1:  Installation Guide 

1.1 Components 

There are four components to MOST: the MFP Application, the MOST Manager, the MOST 
Designer and the MFP Control Center. Below is a brief description of each component.  

1.1.1 MOST Java Application 

The application resides within the MFP and consists of several visual interface components that 
are accessible through the touch screen panel or MFP console controls.   

1.1.2 MOST Manager 

The MOST Manager resides on the delivery service server. The MOST Manager must be running 
if service mode is off for MOST to operate.  The MOST Manager can also be configured to run as 
a Windows service that can be started automatically. The MOST Manager is used to configure 
delivery settings used by MOST.  You can configure server IPs, encryption, database 
information, logging, synchronization and other settings using the MOST Manager.  

1.1.3 MOST Designer 

The MOST Designer is a graphical tool that is used to create and manage users and groups of 
users. It also features a drag and drop interface to enable easy development, modification and 
deployment of new Tabs and Collections. 

1.1.4 MFP Control Center 

The MFP Control Center allows MOST to be installed from a computer onto an MFP.  You can 
specify specific IP addresses or a range to make installation simpler. 

1.2 Installing MOST on your MFP: Getting Started 
 

1) Before continuing, be sure that the latest version of JavaTM Platform is installed and 
running on the MFP. 

2) The MOST Manager options must be set correctly first. To do this, complete the 
following steps. 

3) Open MOST Manager (Start>Programs>Reform...>MOST>Manager).  Click on Edit > 
Settings. 
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4) Here, you can change the Port that MOST will use to connect to the server, as well as 
the IP Address of the host computer. (Default port is 15000).   
a. The only IP in the list should be the cƻƳǇǳǘŜǊΩǎ LtΦ  5ŜƭŜǘŜ ŀƴȅ ƻǘƘŜǊ LtΩǎ ƘŜǊŜΦ 
b. The port number does not need to be changed unless there is a problem that 

does not allow the use of this port. 
c. Be sure that that the Port, File Port and File Server port are not being blocked by 

a firewall.  By default, these values are 15000, 15002 and 8080 respectively.  For 
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more information about these ports and firewalls, please see the trouble 
shooting section of this documentation.     

d. Remember the IP Address and Port because they will need to be entered into 
MOST at the MFP or used when installing MOST.  

e. Make sure that the Enable File Server option is checked. 
f. Also keep note of the File Server Port to use it later when installing MOST on the 

MFP using the built in web server method.  (Default File Server Port is 8080) 
5) Also check that in the Spoolers tab, the Spooler Directory is correct, as shown above.   
6) When your settings are correct, click Save. Allow the MOST Manager to restart. 
7) Now we need to start the MFP Control Center.  This can be done in one of two ways.  

In the MOST Manager, click Tools > MFP Control CenterΧΦ ƻǊ ōȅ ƎƻƛƴƎ ǘƻ 
Start>Programs>ReformΧ>MOST>Install to MFPs 

 

 
 

8) On the MFP Control Center, click Edit > ah{¢ {ŜǘǘƛƴƎǎΧ 
 

 
 

Note: The simplest way to configure the MFP Control Center with the necessary settings is the 
use the provided Wizard. Advanced settings such as Copy Counter and Function locking will be 
discussed in the section following the wizard.  Reform Tracker is required to utilize the Copy 
Counter function of MOST.  Function Locking allows you to specify which users have access to 
certain functions at the MFP.  If enabled, users will be locked out of the enabled function.  The 
Reform Tracker is then required to configure which functions get enabled for the specified 
users or groups. 
 

9) Click the Wizard button in the bottom left of the window. 


